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Preface 
 

 This activity book is a part of the Mathematics subject (Extra Math 1). The purpose of this 
activity book is to provide student basic mathematics skills in using technology with Geometry 
Sketchpad program (GSP).   
 For beginners, there are fifteen topics which are all about construct Geometry with GSP 
program in secondary. Most topics are short and simple with clear explanations.  
 I hope who goes through it will find it useful and worth learning. However, there are still 
some mistakes. And I welcome suggestions from students to improve the books for students in 
the next generation.  
 

Teacher Sunisa Pengmanee 
                 Compiler 
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Google Classroom 

1. Login your Gmail and then joint Extra Math Classroom 

M.1/1 

 

Classroom-code for joint in classroom: kck763f 

M.1/2 

 

Classroom-code for joint in classroom: o5h6oa3 

2. Your Name in G-mail: Please use your full-name 

Example:  



P a g e  1   

 

 

          The Geometer’s Sketchpad (GSP) 

Demonstration School of Suan Sunandha Rajabhat University (English Program) 

Teacher: Sunisa Pengmanee Subject: Extra Math 1 (M.1) 

 

 

 

 

Introduction to The Geometer’s Sketchpad (GSP) 

 

 

 

 

 

 

 

 

 

 



P a g e  2   

 

 

          The Geometer’s Sketchpad (GSP) 

Demonstration School of Suan Sunandha Rajabhat University (English Program) 

Teacher: Sunisa Pengmanee Subject: Extra Math 1 (M.1) 

 

The Geometer’s Sketchpad (GSP) 

1. What Is the Geometer’s Sketchpad? 
 For millennia, drawing and visualization have been important parts of mathematics. A primary 
skill taught in geometry classes has long been compass and straightedge construction; in algebra, it’s 
been function plotting. Paper-and-pencil work will always have an important place in math classrooms, 
but it has two major drawbacks: It’s time-consuming (or sloppy), and the finished products are static. It’s 
easy to see how a computer program like The Geometer’s Sketchpad can solve the time problem: 
Commands such as Angle Bisector and Reflect instantly perform tasks that would take a much longer 
time with pencil and paper, allowing you to construct and explore many more—and much more 
complex—figures in a given amount of time.  
 

What You Should Know about Sketchpad 

 

 

 

 

 

 

 

 

 

 

 

 

Opening an Existing Sketch 
 For thousands of years, since the time of Euclid, the fundamental tools of geometry have been 
the compass and the straightedge. Sketchpad’s Toolbox includes these two tools — used to construct 
circles and straight objects — and several other tools that allow you to select and drag objects, to 
construct points, to create and manipulate text and labels, and to define and manage custom tools. 
This section describes how to use each of the tools in Sketchpad’s Toolbox. 
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2. The Geometer’s Sketchpad (GSP) V 4.0  
1. Open the Geometer’s Sketchpad 
2. Notice below what each button at the left of the screen will do 

 
    2.1 The first row indicates three versions of arrows.  

 The first arrow is used to click and select a point or line and   
 move it in any direction. 

 The second arrow is used only to rotate points and lines.  

 The third arrow is used only to move points together or further   
 away to create shorter or longer lines. 
 

 2.2 The second row is a button that is used to create points. 
 2.3 The third row is a button that is used to create circles. 
 2.4 The fourth row indicates three versions of lines.  

 The first is used to create a line segment.         

 The second is used to create a ray.  

 The third is used to create a line. 
 2.5 The fifth row is a button that is used to insert text. 
 2.6 The last is used to create tools. This is a more advanced topic and allows buttons to be 
created as well as java scripts.  
3. Using these buttons and tools insert circles, lines, and points 
 Notice that if you want to connect two lines when you put the arrow over one endpoint it is 

highlighted blue. This is how you know they are connected and not near each other. 

 
 Notice that if you want to put a point ON a line the line will be highlighted blue. This is how 

you know that the point will be on the line and not near it. 
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3. The Geometer’s Sketchpad (GSP) Ver.5.0 

 The Toolbox appears on the left of the screen when you start Sketchpad, and includes nine tools. 

 

 Selection Arrow tools: Use these tools to select and drag 
objects in your sketch. The three variations of the tool 
allow you to drag-translate (move), drag-rotate (turn), 
and drag-dilate (shrink or grow) objects. 

 Point tool: Use this tool to construct points. 

 Compass tool: Use this tool to construct circles. 

 Straightedge tools: Use these tools to construct straight 
objects. The three variations of the tool allow you to 
construct segments, rays, and lines. 

 Polygon tools: Use these tools to construct polygons. The three variations of the tool allow you 
to construct a polygon, a polygon and the segments that form its edges, or the edge segments 
only. 

 Text tool: Use this tool to create and edit text and labels. 

 Marker tool: Use this tool to create angle markers and tick marks, and to make freehand drawings 
and notations. 

 Information tool: Use this tool to explore how a sketch is constructed and how the objects 
relate to each other. 

 Custom tools icon: Use this icon to define, use, and manage custom tools 

Moving, Resizing, and Docking the Toolbox 
 

     To move the Toolbox, (Windows or Macintosh) grab it by the title bar or 

   (Windows only) by the gray area surrounding the buttons and drag it to  

   a different location on the screen. Windows users can dock the Toolbox to  

   the left, top, right, or bottom edge of the application window. When  

   the Toolbox is not docked, Windows users can also resize the Toolbox by  

  dragging a border of the Toolbox window. Macintosh users can make the Toolbox large or 

small by choosing Edit | Preferences | Tools. 
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4. Menus 
 This section describes the commands in Sketchpad’s menus. 

 1.1 The File menu allows you to create, save, and print entire documents. 

 1.2 The Edit and Display menus contain commands that alter the appearance, format, or 

definition of existing objects in your active sketch. 

 1.3 The Construct, Transform, Measure, Number, and Graph menus all allow you to define new 

mathematical content in the active sketch, often by creating new objects related to selected objects. 

 1.4 The Window menu (Microsoft Windows and Macintosh OS X only) lets you manage open 

document windows on your desktop. 

 1.5 The Help menu contains links to the Sketchpad Learning Center, to this Reference Center, 

to the Sketchpad Resource Center, and to the Picture Gallery. 

 1.6 The Context menu appears when you right-click (Windows) or Ctrl + click (Macintosh) in the 

sketch, and presents options relevant to the clicked object, or to the sketch document if the click was 

in empty space. 

 1.7 The Custom Tools menu appears when you press and hold the Custom tool icon at the 

bottom of the Toolbox. 

 The Macintosh edition of Sketchpad contains a Sketchpad application menu in addition to the 

menus listed here. This application menu contains standard commands used by all Mac applications, 

and isn’t discussed here. 

 

 

 

 

 

 

 

 

 

Picture from https://geometers-sketchpad-online-free.peatix.com/ 
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Activity 1 
Introducing Points, Segments, Rays, and Lines 

 

 In this activity, you'll experiment with drawing, dragging, measuring, and labeling points, segments, 
rays, and lines. These objects, along with circles, are the building blocks of most geometric constructions. 
 

1. Sketch and investigate: Points and Segments 
    Note: If at any time you think you've made a mistake or you want to do something differently, you  
    can always undo as many steps as you like. The Undo and Redo commands are in the Edit menu. 
 

 

1. Choose the Point tool and click in the sketch to  
    construct a point Click again to construct a second  
    point. Notice that the most recently constructed  
    point is selected: It appears with an outline. 

 

 

2. Choose the Selection Arrow tool and click in a  
    blank area in the Arrow tool I sketch. This deselects  
    everything. 

 

 

3. Choose the Text tool. Position the finger over a  
    point, then click to display that point's label. Display  
    the other point's label, too. 

 

 
4. With the Selection Arrow tool, click on both points.  
   Now both points should be selected.  

 5. In the Measure menu, choose Distance. 

 
 

6. Drag one of the points and observe the  
   measurement. 

 

7. Choose the Segment tool and draw a segment  
    connecting the two points. You'll see a triple  
    segment at first, indicating that the segment is  
    selected. 

 
 

8. With the segment selected, go to the Measure  
    menu and choose Length. 

 
9. Use the Selection Arrow tool to drag either  
    endpoint of the segment. 
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10. Use the Segment tool to construct a second  
    segment with one endpoint attached to the first  
    segment. To do this, click the mouse button first  
    when the pointer is in a blank area of the sketch,  
    then when it's directly.  

 
11. Use the Text tool to show the labels of this  
     segment's endpoints. 

 

 
12. Use the Selection Arrow tool to drag point D to  
     confirm that it is attached to AB. 

 

 
13. Select Cn line segment, not its endpoints), then go  
      to the Construct menu and notice what choices  
      are available. Choose Midpoint. 

 

 14. Click in a blank area to deselect everything. 
 15. Select point D. 

 

16. In the Edit menu, drag to the Action Buttons  
     submenu and choose Animation. You'll get      
     a dialog box you can use to specify animation  
     settings. To choose the default settings, click OK.  
     You've created an Animation action button in your  
     sketch. 

 

 
17. Press the action button (by clicking on it) to start  
     the animation. 

 

 18. Press the button again to stop the animation.  

 
19. Select the midpoint; they, in the Display menu,  
     choose Trace Midpoint. 

 

 
20. Press the Animation button again and observe  
     the path that the midpoint traces 
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2. Sketch and Investigate: Rays and Lines 
 

 21. In the File menu, choose New Sketch.  

 

22. Press and hold down the mouse button on  
     the Segment tool. A palette of Straightedge tools  
     will pop out to the right. Drag right and choose  
     the Ray tool. 

 

 
23. Draw array in your sketch. Notice that the ray  
     extends in one direction beyond the edge of your  
     sketch window. 

 

 
24. Use the Text tool to show the labels of the ray's  
     control points. 

 

 
25. Use the Selection Arrow tool to drag each point to  
     observe how it controls the ray. 

 

 
26. Select the ray and go to the Measure menu. Note  
     that Length is grayed out. 

 

 
27. With the ray still selected, go to the Construct  
     menu and look at your choices. Choose Point  
     On Ray. 

  
28. Drag this new point to see how its behavior  
     compares to that of the ray's two control points. 

 
29. Press and hold down the Ray tool, then drag right  
     to choose the Line tool. 

 

 30. Experiment with drawing lines in your sketch.  
 

Question 1: From step 5Two rays with a common endpoint form an angle. The common endpoint of  
              the rays is called the vertex of the angle. Name the vertex of the angle you just made. 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
Question 2: Angles are usually named after three points: a point on one side, the vertex, and a point  
                on the other side. What are two possible names for the angle you just made? 
 ………………………………………………………………………………………………………………………………………………………………

 ………..…………………………………………………………………………………………………………………………………………………... 
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Activity 2 
Introducing Angles 

 
 An angle is sometimes defined as two rays that share an endpoint. But two segments with a 
common endpoint also determine an angle. And we usually name an angle after three points. If that's 
not confusing enough, angle measure is usually considered something different from an angle. In this 
activity, you'll explore angles and angle measures with Sketchpad. 
 
 

Sketch and investigate 
 
 

 1. In the Edit menu, choose Preferences. Set the angle unit to degrees with precision to  

              the nearest tenth. Angle Units and Precision menus from the Preferences dialog box. 

 2. Use the Ray tool to construct AT. 

 3. Construct another ray AC, with the same endpoint A. 

 4. Drag each of the three points to make sure the two rays always  

     share a common endpoint (point A).  

 5. If necessary, use the Text tool to display A the point labels.  

              Change them to match the figure.  

 6. Select, in order, points B, A, and C; then, in the Measure menu, choose Angle. 

 7. Drag point B or point C and observe how the angle measure changes. 

 8. Draw a circle centered at Point A but not attached to and other points in your sketch. 

 9. Select the circle and point C; then, in the Edit menu,  

     choose Merge Point To Circle. Point C will attach itself  

     to the circle.  

 10. Make an action button to animate point C around  

               the circle. 

 11. Press the button (click on it, in other words) to play it.  

      Watch the angle measurement during the animation.  

               (Press the button again to stop the animation,) 
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Activity 3 
Euclid's Proposition: An Equilateral Triangle 

  

             Euclid, a Greek mathematician born around 300 S.C., wrote  
     a book called the Elements, upon which most school geometry  
    books are still based. All of the geometry in the Elements is built  
    up sequentially from a few simple constructions and postulates.  
    Each new property that Euclid presents, or new figure that he constructs, is 
based on Properties he has demonstrated previously. The construction that starts it all is the equilateral 
triangle. Countless other constructions in the Elements depend on being able to construct an equilateral 
triangle with compass and straightedge. In this activity, you'll construct an equilateral triangle using only 
Sketchpad's freehand tools-the equivalents of Euclid's compass and straightedge. 
 

Sketch and investigate 
 1. Construct AB. 
 2. Construct circle AB. (Make sure you use point A for the center  
              and point B for the radius-defining point.) 
 3. Construct circle BA. (Use point B for the center and point A for the radius point this time.) 
 4. Construct AC and CB where C is a point of intersection of the two circles.  
 5. Hide the circles. 
 6. Measure the three angles.  
 

Question1: Drag point A or point B. What happens to your triangle? Does it appear to stay equilateral? 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
Question2: Explain why this triangle is always equilateral. (Hints: What roles do the circles play in your  
                 construction? How are they related to one another? How are the sides of the triangle  
                 related to the circles?) 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
Question3: Drag point A or point B. Make a conjecture about the angles in an equilateral triangle 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
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Activity 4 
Euclid’s Proposition: A daisy design 

 
 A daisy design is a simple design that you can create using only a compass. From the basic daisy, 
you can create more complex designs based on the regular hexagon. 
1. Construct circle AB (a circle with center A and radius point B). 
2. Construct circle BA. Be sure you start your circle with the cursor  
    positioned at point B and that you finish your circle with the cursor  
    positioned at point A. 
3. Drag point A and point B to confirm that both circles are controlled 
    by these two points. 
4. Construct point C and point D, the two points of intersection of these circles. 
5. Construct a circle from point C to point A. 
6. Continue constructing circles from new intersection points to point A. 
    All these circles should have equal radii. The last circle you construct should be centered  
   at point D. When you’re done, your sketch should look like the figure below right. You should  
   be able to drag it without making it fall apart. 

 
 
7. Use the Segment tool to add some lines to your design; then drag point B and observe the way  
   your design changes.  
 The six points of your daisy (besides point A) define six vertices of a regular hexagon. You can 
use these points as the basis for hexagon or star designs like those shown on the next page. You could 
construct polygon interiors and experiment with color.  



P a g e  13   

 

 

          The Geometer’s Sketchpad (GSP) 

Demonstration School of Suan Sunandha Rajabhat University (English Program) 

Teacher: Sunisa Pengmanee Subject: Extra Math 1 (M.1) 

 
 You could also construct arcs (select a circle and two points on it) and arc sector and arc segment 
interiors (select an arc). Flowerer, you can probably get better results by printing out the basic line design 
and adding color and shading by hand. Once you have all the lines and polygon interiors you want, you 
can hide unneeded points. Don’t hide your original two points, though, because you can use these 
points to manipulate your figure. 

 
 
Explore More 
Daisy Designs (continued) 
 1. Use the daisy concoctions to create a custom tool for a regular hexagon. Save the new tool 
in the Tool Folder (next to the application itself on your hard drive) so it can be used in any open sketch. 
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Activity 5 
Duplicating a Line Segment 

 
 This method for duplicating a line segment with Sketchpad is equivalent to the standard 
compass-and-straightedge construction. However, Sketchpad's compass (the Compass tool) is 
collapsible, like Euclid's compass, meaning that after you make a circle you can't just pick up the tool, 
move it somewhere else, and make another circle the same size. As soon as you pick up Euclid's compass 
(or release the mouse button when you're using Sketchpad's Compass tool), you lose your compass 
setting. Duplicating a segment using only Sketchpad's freehand tools (or Euclid's tools) is more 
complicated than you'd expect. We'll get around this by using the Construct menu. This construction is 
the basis for many more complex constructions. 

Sketch and Investigate 

 1. Construct AB. This is your given segment. 
 2. Construct point C. This is one endpoint  
              of your new segment. 
 3. Select AB and point C; then, in the Construct menu,   
             choose Circle By Center + Radius. 
 4. Construct CD, where point D is on the circle. 
 5. Hide the circle. Measure AB and. CD. 
 6. Drag points C and D.  
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Question1: Describe the way each behaves. 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
 
Question2: Drag point A or point B. What effect does changing the length of AB have on CD? 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
 
Question3: Write a paragraph describing why this construction works and comparing it to the way you  
                 would duplicate a segment using a compass and straightedge. In your paragraph, explain  
                 why it is necessary to use the command Circle by Center + Radius instead of using  
                 Sketchpad's Compass tool. (In other words, explain what you can do with an actual  
                compass that you can't do with Sketchpad's compass.) Use a separate sheet, if necessary. 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
 ………………………………………………………………………………………………………………………………………………………………
 ………..…………………………………………………………………………………………………………………………………………………… 
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Activity 6 
Duplicating an Angle 

 
 In this activity, you'll learn how to duplicate a given angle. The method described is equivalent 
to the method you would use with a compass and straightedge. You might want to follow the first few 
steps, then try to figure out the rest on your own. 

1. Construct AB and AC (This is your given angle.) 

2. Below angle CAB, construct DB, side of a new angle.  

3. Construct circle AF, with point F on A. 

4. Construct AF overlapping AB.  

5. Construct FG where point G is the point of intersection  
    of the circle and AC. 

6. Construct a circle with center D and radius equal to AF. 

7. Construct H, the point of intersection of this circle with DE. 

8. Construct a circle with center H and radius equal to FG. 

9. Construct DI where point I is the point of intersection of these two circles. 

10. If you wish, hide the circles, the segments, and points H, F, and G. 

11. Drag point A, B, C, D, or E and observe how the angles behave. Measure the angles to confirm your  
     observations. 
Question 1: Explain why this construction works the way it does. 
 ...................................................................................................................................................................................
 ...................................................................................................................................................................................  
 ................................................................................................................................................................................... 
Explore More 
1. Here's an easier way to duplicate an angle using the Transform menu instead of Euclidean tools:  
    Construct rays AB and AC to construct angle CAB. Select, in order, points B, A, and C; then, in the  
    Transform menu, choose Mark Angle. Construct DE. Mark point D as center and rotate the ray by  
    the marked angle. 
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Activity 7 
Angles Formed by Intersecting Lines 

 

 When two lines intersect, they form four angles. The point of intersection of the lines is the 
vertex of all four angles. In this activity, you'll investigate relationships between pairs of these angles. 
Sketch and Investigate 

1. Construct AB and CD so that they intersect. 
 2. Construct point E where the lines intersect.  

 3. Measure the four ∠  DEB, ∠  BEC, ∠  CEA, 

              and∠  AED. 
 4. Drag points B and C and look for relationships  
              among the angle measures. Make sure to keep  
              point E between points A and B and between points C and D 

Question 1: In your sketch, ∠ DEB and ∠ CEA are a pair of vertical angles.  
       a. Name another pair of vertical angles.  
           ............................................................................................................................. ......................................... 
           .................................................................... ..................................................................................................
       b. Write a conjecture about the measures of vertical angles. 
           ......................................................................................................................................................................  
           ...................................................................................................................................................................... 

Question 2: In your sketch, ∠ CEB and ∠DEB are a linear pair because two of their sides form a line.  
       a. Find and name all the other linear pairs in your sketch.  
           ...................................................................................................................................................................... 
           ......................................................................................................................................................................
       b. Write a conjecture about the relationship between angles in a linear pair.  
                    Use the Calculator to test your conjecture. 
           ...................................................................................................................................................................... 
           ......................................................................................................................................................................  

 5. Make a Hide/Show button for three of the four angles. 
 6. Press the new button (in other words, click on it). It should hide the three angle measures. 
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Question 3:  Drag a point so that the one visible angle measure is 63o. Find the measures of the other  
                   three angles without looking. Write your guess below, then press the button to check 
          your guess. 
           ...................................................................................................................................................................... 
           ......................................................................................................................................................................  
           ...................................................................................................................................................................... 
           ...................................................................................................................................................................... 
 7. Test yourself a few more times for practice: Hide the angle measures, drag to change  
               the angles, guess at the hidden angle measures, then check your guess. 

Explore More 
1. Suppose you had three lines intersecting in a single point to form six angles. 
 A. How many angle measures would you need to know in order to find the other angle? 
 B. Describe any situations in which all the angles are congruent. 
2. Suppose you have four lines intersecting in a single point to form eight angles. Answer parts A and B   
    from Explore More 1, above, for this different case. 
3. Now generalize your results from the last two questions. Suppose you had n lines intersecting to  
    form 2n angles. Answer parts A and B from Explore More 1, above, for this general case. 
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Activity 8 
Properties of Parallel Lines 

 
 In this investigation, you'll discover relationships among the angles formed when parallel lines 
are intersected by a third line, called a transversal. 

Sketch and Investigate 
 1. Construct AB and point C, not on AB 

 2. Construct a line parallel to AB through point C. 

 3. Construct CA. Drag points C and A to make sure the three lines are attached at those points. 

 
   Step 1            Step 2 and 3 
 
 4. Construct points D, E, F, G and H as shown at right. 

 5. Measure the eight angles in your figure. Be systematic  

              about your measuring to be sure you don't measure  

              the same angle twice. 

 6. Drag point A or B and see which angles stay  

              congruent Also drag the transversal CA. (Be careful                                       Step 4 

              not to change the point order on your lines. That would                            

              change some angles into other angles.) Observe how many  

              of the eight angles you measured appear to be always congruent. 
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Question 1: When two parallel lines are crossed by a transversal, the pairs of angles formed have  
                   specific names and properties. The chart on the next page shows one example of each  
                   type of angle pair. Fill in the chart with a second angle pair of each type, then state what  
                   relationship, if any, you observe between the angles in a pair type. 
 

Angle Type Pair 1 Pair 2 Relationship 

Corresponding ∠ FCE and ∠ CAB   

Alternate interior ∠ ECA and ∠ CAG   

Alternate exterior ∠ FCE and ∠ HAG   

Same-side interior ∠ ECA and ∠ BAC   

Same-side exterior ∠ FCD and ∠ HAG   

 
Question 2: One of the angle types has more than one pair. Name that angle type in the chart below,  
                  and name the third and fourth pairs of angles of that type. 

Angle Type Pair 3 Pair 4 Relationship 

    

 
 7. Next, you'll investigate the converses of your conjectures. In a new sketch, draw two lines  

     that are not quite parallel. Construct a transversal. 

 8. Add points as needed, then measure all eight angles formed by the three lines. 

 9. Move the lines until you have two sets of four congruent angles. 
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Activity 9 
Constructing a Perpendicular Bisector 

 In this activity, you'll use only Sketchpad's freehand tools to construct perpendicular bisectors. 
Then you'll investigate properties of perpendicular bisectors. In Explore More, you'll devise a shortcut 
for constructing a perpendicular bisector using Sketchpad's Construct menu. 
Sketch and Investigate 
 1. Construct AB. 
 2. Construct circle AB. (Make sure you use point A  
              for the center and point B for the radius endpoint) 
 3. Construct circle BA. (Use point B for the center and  
     point A for the radius point.) 
 4. Construct CD, where C and D are the circles' points  
     of intersection. 
 5. Drag points A and B to make sure your construction stays together. 

Question 1: Line CD is the perpendicular bisector of AB. Without measuring, what can you say about 
         the distances AC and BC and the distances AD and BD? 
         .................................................................................................................................................................. ...... 
         ........................................................................................................................................................................  
         ........................................................................................................................................................................  

 6. Construct E, the point of intersection of AB and CD. 

Question 2: What's special about point E? Move points A and B to confirm your answer. 
         ........................................................................................................................................................................  
         ........................................................................................................................................................................  
         ........................................................................................................................................................................  

 7. Hide the circles. 
 8. Construct a point F on CD  
 9. Measure the distances FA and FB. 

Question 3: Drag point F up and down the line. Make  
                   a conjecture about any point on a segment's perpendicular bisector. 
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Explore More 
 In a new sketch, construct a segment. Figure out how to construct the perpendicular bisector of 
the segment using the Construct menu. When you've succeeded, make a custom tool and save it in the 
Tool Folder (next to the application itself on your hard drive). Write a description of the way you did 
the construction. 
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Activity 10 
Distance from a Point to a Line 

 Measuring the distance between two points is easy, but how do you measure the distance 
between a point and a line? There are many different distances, depending on what point you measure 
to on the line. What's the shortest distance? That's what you'll investigate in this activity. 
 1. Construct AB.  
 2. Construct point C not on AB 
 3. Construct CD, where point D is on AB.  
 4. Measure CD. 
 5. Drag point D back and forth along the line and  
              observe where CD becomes great and where it  
              becomes small. 
 6. Locate point D to make CD as small as you can. 
 7. Measure the distance from point C to AB. 

Question 1: How does CD compare to the distance from C to 
         ................................................................................................................................. ....................................... 
Question 2: How does CD seem to be related AB? 
         ........................................................................................................................................................................  

 8. Measure ∠CDB to confirm your conjecture in questionQ2. 

Question 3: How would you define the distance from a point to a line? 
         ........................................................................................................................................................................  
 

Explore More 
 1. Model this problem in Sketchpad: 
  There's a sewage treatment plant at the point where two rivers meet. You want to build 
a house near the two rivers (upstream from the sewage plant, naturally), but you want the house to be 
at least 5 miles from the sewage plant. You visit each of the rivers to go fishing about the same number 
of times, but, being lazy, you want to minimize the amount of walking you do. (You want the sum of 
the distances from your house to the two rivers to be minimal.) Where should you build your house? 
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Activity 11 
Angle Bisectors 

 
    An angle bisector is a ray that has its endpoint at the vertex of the angle 
   and that divides the angle into two angles of equal measure. In this investigation, 
  you'll investigate a special property of points on an angle bisector. 

1. Construct AB and AC to form ∠BAC  

2. Construct the bisector of ∠BAC. 
3. Drag point B and observe the angle bisector 
4. Construct point D on the angle bisector. 

   Question 1: Drag point D. Without measuring, make a guess about the distances 
            from point D to each of the angle's two sides. 
           ................................................................................................................................ 

5. Measure the distance from point D to AE. 
6. Measure the distance from point D to AC 
7. Measure angles BAD and DAC. 

   Question 2: Drag point A, B, or C to change ∠BAC. How do the measures of  

            ∠ BAD and ∠DAC compare? 
           ................................................................................................................................ 
   Question 3: Drag point D and observe the distances from point D to the two  
            sides of the angle. Write a conjecture about any point on an angle  
            bisector. 
           ................................................................................................................................ 
           ................................................................................................................................ 
Explore More 
1. In a new sketch, draw rays AB and AC. Mark AC as a mirror. Reflect AB. Drag different points in your  
   sketch. How are AB and AC related? 
2. In a new sketch, see if you can construct an angle bisector using only Sketchpad's freehand tools- 
    not the menus. Make a custom tool for this construction and save it in the Tool Folder (next to the  
    application itself on your hard drive). 
3. Write the converse of your conjecture in Question 3. Is the converse true? Demonstrate the  
    converse with sketchpad and explain what you did. 
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Activity 12 
Trisecting an Angle 

  
 Trisecting an angle with a compass and straightedge is a construction problem that has occupied 
professional and amateur mathematicians for centuries. Even though it has been proven that the 
construction can't be done, countless people still think they've found a solution. Others enjoy slightly 
bending the rules that govern compass-and-straightedge constructions to devise simple angle-trisection 
methods. It is possible to trisect an angle using Sketchpad, because you can rotate by marked measures 
and calculations. 
Sketch and Investigate 
 1. In Preferences, set Angle Units to 
    directed degrees. 
 2. Construct AB and AC as shown to form 
     the angle you will trisect. 

 3. Measure ∠BAC. 

 4. Calculate 
m∠BAC

3
 

 5. Select the calculation; then, in the Transform menu, choose Mark Angle. 
 6. Double-click point A to mark it as a center of rotation. 
 7. Rotate AB by the marked angle. 
 8. Rotate this new ray again by the marked angle. 
Question1: Drag points on the angle and observe the behavior of the trisectors. Explain why they 
        remain trisectors. 
        .......................................................................................................................................................................... 
        .......................................................................................................................................................................... 
        .......................................................................................................................................................................... 
 Your construction method was similar to what you could do with a protractor. Because you used 
the angle's measure to trisect it, this method doesn't qualify as a compass-and-straightedge construction. 
Constructions using only the freehand tools and the Construct menu would be equivalent to compass-
and-straightedge constructions. 
Explore More 
 1. Draw a triangle with extended sides using the Line tool. Trisect the three interior angles. Find 
     an interesting shape formed by intersecting trisectors. 
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Activity 13 
Drawing a Box with Two-Point Perspective 

  

 Even though a piece of paper or a computer screen is flat, you can draw figures that appear 
three-dimensional on these three-dimensional surfaces by using perspective drawing. In three 
dimensions, objects that are farther away appear smaller. Perspective drawing takes advantage of this 
principle to make flat drawings appear to have depth.  
 Follow these steps to draw a box with two-point perspective. Labels are shown to clarify these 
directions, but you probably won't want labels on your drawing. 
Sketch and Investigate 

 1. Draw a long horizontal line segment AB. This will be your horizon line, and its endpoints will 
be the vanishing points of your perspective box. 
 2. Draw a short vertical segment CD below your horizon line. This will be the front edge of your 
box. Change its line width to dash.  
 3. Construct CA, DA, CB, and DB. 

 
 

 4. Construct point E on DA and point F on DB. 
 5. Through points E and F, construct lines parallel to CD. 
 6. Construct GB and HA, where points G and H are the points where the parallel lines intersect 
     CA and CB 
 7. Construct point I at the point of intersection of GB and HI. 
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8. Change the line width of CD to thick, then complete the box by constructing GI, HI, HF, FD, DE, EG,       
    GC, and CH. 

 
 
9. Hide all the dashed lines and segments to leave just your box and the horizon line. 

 
10. Try moving various parts of your box, your horizon segment, and the vanishing points. If you move  
     the front edge of your box above the horizon segment, you'll discover that you haven't created  
     the bottom of your box. Continue sketching to construct the missing edges as shown. (Hint: Start  
     by constructing a dashed segment from point E to point B.) 

 
11. Hide unwanted points and segments. 
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Activity 14 
Constructing a Square 

 

 
 

Step for constructing a square 
1. Click the straightedge tool and select Segment Tool, then click two different locations on the 

drawing area. 
 

2. Click the Selection Arrow Tool, click on a blank space in the drawing pad to deselect the 
segment. To show the label of the two points, select the two points, click the Display menu, 
then click Show labels. Notice that GSP names the points alphabetically – the first A and the 
other B. 
 

3. To construct two lines perpendicular to segment AB, one passing through A and the other through B, 
click the segment (be sure that the two points are also selected), click the Construct menu, then 
click Perpendicular lines. Your construction should look like the one shown in Figure 1. 
 

 
Figure 1: Segment AB and the GSP toolbar. 
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Figure 2: Segment AB with lines perpendicular to it passing through its endpoints. 

 

4. Next, we will construct a circle with center B passing through A. To do this, click the circle tool, 
click point B and then click point A 

5. We will now intersect the circle and the line passing through point B. To do this, click the Point 
tool, hover over the intersection of the circle and the line through B, wait for the two objects to 
change their color to cyan, then click their intersection 

6. To display the label of the third point, with the third point selected, click the Display menu, 
then click Show label.  

 
Figure 3: Point C is the intersection of the circle and the line passing through B 

 

7.  Next, create a circle with center A and passing through B. Refer to step 4. 
8. Intersect the line passing through A and the circle with center A to construct point D. 
9. Show the label of the fourth point. 

 
Figure 4: ABCD is going to be the vertices of the squares 
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10. Next, we will hide the circles and the lines. Click the Selection Arrow tool, click the two circles 

and the two lines, and then click Hide Path Objects. 
11. To form the square, use the Segment tool to connect the vertices of the square. 
12. Move the vertices of the square and observe what happens.  Explain why your observation is such. 
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Activity 15 
Constructing a rectangle 

 

 
 

Step for constructing a rectangle 
1. Open Geometer’s Sketchpad. 
2. Construct a segment using the Segment tool. 
3. Select the Text tool and click the two points to create their labels. These points are named A  

and B. 
4. Next, we construct a line which is perpendicular to AB and passing through A. To do this, select the 

Selection Arrow tool and click on a blank space on the sketch pad to deselect all the objects. 
5. To construct the perpendicular line, select point A and the segment AB, and the click the Construct 

menu from the menu bar, and choose Perpendicular line. 
6. Using the same steps, construct a line perpendicular to AB and passing through B. Note: You can also 

create two perpendicular lines at a time by selecting the two points and the segment. 
7. To construct a point on the line passing through A, deselect all the objects by clicking the Selection 

Arrow and clicking on the blank space in the sketchpad. Select the line passing through A, click the 
Construct menu, and then click Point on Perpendicular Line. 

8. Now use the Text tool to label that point as C (Figure 2). 

 
Figure 2 
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9. To construct a line parallel to AB, deselect the line, select segment AB (be sure that 

points A and B are not selected), select point C, click the Construct menu from the menu bar, 
and select Parallel Line. 

10. Now, to create our fourth vertex, select the line perpendicular to BC, and the line through A, and 
then click Intersection from the Construct menu. 

11. Click the Text tool and click the fourth vertex to name it D.  

 
Figure 3 

 
12. Now, we hide the lines. Select the three lines, click the Display menu, and click Hide Lines. 
13. Now, connect the three vertices using the Segment tool to form the rectangle. Move the vertices 

and observe what happens. 
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Activity 15 
Constructing an Equilateral Triangle 

 

 
 

Step for constructing an Equilateral Triangle 
1. Click the circle tool, determine the center by clicking a location on the drawing pad, move the 

mouse to determine the radius, and click another location to draw the circle. If you made a 

mistake, just click the Edit menu and choose Undo from the list. 

 

Figure 1: The toolbar contains the different tools of Sketchpad used for drawing. 

2. Click the arrow selection tool and try to drag the two points. What do you observe? 

3. We now show the label of the two points. Click the two points, then click the Display menu 

from the menu bar, then click Show labels from the drop-down menu. Notice that Geometer’s 

Sketchpad names the objects in alphabetical order, the center of the circle is named A and the 

point on the circle is named B. 

http://mathandmultimedia.com/wp-content/uploads/2009/12/sketchpad1-2.png
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Figure 2: The Display drop-down menu. 

4. To construct a circle with center point B and passing through A, click the compass tool, click 
point B and click point A. Your drawing should look like the one shown in Figure 3. 

 

Figure 3: Circe with center A and passing through B and circle with center B passing through A. 
 

5. Next, we construct the intersections of two circles. Click the selection arrow tool, click then 
select the two circles. (Be sure that only the two circles are selected. To deselect an object, 
click anywhere on the drawing pad). 

 

Figure 4: The two circles are selected. 

http://mathandmultimedia.com/wp-content/uploads/2009/12/sketchpad1-3.png
http://mathandmultimedia.com/wp-content/uploads/2009/12/sketchpad1-4.png
http://mathandmultimedia.com/wp-content/uploads/2009/12/sketchpad1-5.png
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6. To construct the intersection, click Construct from the menu bar, then Intersections from the 

drop-down menu bar. 

7. Display the name of the two intersections by clicking both of them and clicking Show labels from 

the Display menu. 

8. Next, we hide the two circles and point D leaving only points A, B and C on the drawing area. 

To do this click the selection arrow tool, click the two circles and point D. 

 

Figure 5: The two circles and point D are selected. 

9. To hide the selected objects, click the Display menu and choose Hide Objects. Notice that the 

only left objects on the drawing area are points A, B and C. 

10. Select segment tool (be sure that you choose the segment tool, not the ray tool or line tool) 

from the straightedge tool, then connect the three points to form triangle ABC. Using 

the selection arrow tool, move the points on the vertices of the triangle. 

 What do you observe? 

 What kind of triangle is triangle ABC? Why do you say so? 
11. Let us try to see if your conjecture about triangle ABC is true. We will display the length of the 

segments. To do this, select one of the sides of the triangle, click Measure from the menu bar 

and choose Length from the drop-down menu. 

 Measure the other two sides. What do you observe? 

 Move the vertices of the triangle. Is your observation still true? 

 Explain why triangle ABC is always an equilateral triangle. 

http://mathandmultimedia.com/wp-content/uploads/2009/12/sketchpad1-6.png
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12. If you want to save your file, click the File menu from the menu bar and click Save from the 

drop-down menu. 

13. Type the file name of your first sketch, choose a location to save, then click Save. 
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